I=,~~====================================================
• •-

•-

Ir~K!:f:~

XENIX* 286
VISUAL SHELL
USER'S GUIDE
Order Number: 174388-002

*XENIX is a trademark of Microsoft Corporation.

Copyright

I

©

1985

Intel Corporation

Intel Corporation, 3065 Bowers Avenue, Santa Clara, California 95051

I

The information in this document is subject to change without notice.
Intel Corporation makes no warranty of any kind with regard to this material, including, but not limited to, the implied
warranties of merchantability and fitness for a particular purpose. Intel Corporation assumes no responsibility for any errors
that may appear in this document. Intel Corporation makes no commitment to update or to keep current the information
contained in this document.
Intel Corporation assumes no responsibility for the use of any circuitry other than circuitry embodied in an Intel product. No
other circuit patent licenses are implied.
Intel software products are copyrighted by and shall remain the property ofIntel Corporation. Use, duplication or disclosure is
subject to restrictions stated in Intel's software license, or as defined in ASPR 7 -104.9 (a) (9).
No part of this document may be copied or reproduced in any form or by any means without prior written consent of Intel
Corporation.
The following are trademarks ofIntel Corporation and its affiliates and may be used only to identify Intel products:

BITBUS
COMMputer
CREDIT
Data Pipeline
Genius
L\
1

i
I2ICE
ICE
iCS
iDBP
iDIS
iLBX

im
iMDDX
iMMX
Insite
inte l
intelBOS
Intelevision
inteligent Identifier
inteligent Programming
Intellec
Intellink
iOSP
iPDS

iRMX
iSBC
iSBX
iSDM
iSXM
KEPROM
Library Manager
MCS
Megachassis
MICROMAINFRAME
MULTIBUS
MULTICHANNEL
MULTIMODULE

OpenNET
Plug-A-Bubble
PROMPT
Promware
QUEST
QueX
Ripplemode
RMXl80
RUPI
Seamless
SLD
SYSTEM 2000
UPI

XENIX and Multiplan are trademarks of Microsoft Corporation. UNIX is a trademark of Bell Laboratories.

REV.

ii

REVISION HISTORY

DATE

-001

Original issue

11/84

-002

Revision

12/85

10/84

intel®

TABLE OF CONTENTS

CONTENTS
CHAPTER 1
INTRODUCTION
Manual Overview
Intended Users
Notational Conventions
Manual Organization
Visual Shell Overview
CHAPTER 2
USING THE VISUAL SHELL
Introduction
How the Visual Shell Works
Status Line
Message Line
Command·Output
How to Use the Visual Shell
Editing Responses to Com mands
Executing a Command
Canceling a Com mand
Redra wing the Screen
Com mand Descriptions
Copy
Copy File
Copy Directory
Delete
Edit
Help
Mail
MAIL: Read
MAIL SEND to:
Name
Options
Options Directory
Options FileSystem
Options FileSystem Filescheck
Options FileSystem Mount
Options FileSystem Unmount
Options FileSystem Spacefree
Options Output
Options Permissions
Print
Quit
Run
View
Window

1-1
1-1
1-1
1-2
1-2

2-1
2-1
2-1
2-1
2-1
2-2
2-2
2-3
2-3
2-3
2-4
2-4
2-4
2-4
2-5
2-5
2-5
2-6
2-6
2-6
2-6
2-7
2-7
2-8
2-8
2-8
2-9
2-9
2-9
2-10
2-10
2-10
2-11
2-11
2-11

iii

XENIX 286 Visual Shell User's Guide

Table of Contents

PAGE

CONTENTS
CHAPTER 3
USING ADVANCED FEATURES
Introduction
Using the Window
Showing the Directory
Showing Text Files
Changing the Window Size
Using the Window with Simple Commands
Modifying the Menus
Adding Commands to the Menus
Deleting Commands from the Menus
Renaming Commands
Creating and Deleting Submenus
Modifying Fill-in Fields
.mnu Files
Creating. mnu Files
Prompts
Fields
Command Lines
Help Text
Example

3-1
3-1
3-1
3-2
3-2
3-3

3-4
3-4
3-5
3-6

3-7
3-8
3-8

3-9
3-9
3-9
3-11
3-11
3-11

APPENDIX A
COMMAND REFERENCE
Keyboard Summary
Key Chart
Command Summary

A-I
A-I
A-3

APPENDIX B
RELATED PUBLICATIONS
Intel Publications

B-1

INDEX

TABLES
TABLE
3-1
3-2

iv

TITLE

XENIX 286 Visual Shell Field Types
XENIX 286 Visual Shell Field Type Default Specifications

PAGE
3-10
3-10

CHAPTER 1
INTRODUCTION

Manual Overview
The XENIX 286 Visual Shell User's Guide is a reference manual for using the XENIX 286
visual shell. The manual provides operating instructions and necessary background
information for the visual shell. Because users are likely to have a wide range of
experience with computers and operating systems, this manual includes both basic
operating information and details on advanced features that enable more sophisticated
users to customize the shell and create their own menus.
Occasionally you will be directed to another book containing more information about a
particular topic; Appendix B contains a list of Intel publications.

Intended Users
The XENIX 286 Visual Shell User's Guide is written for those familiar with XENIX basic
concepts and need to use the visual shell. Users should read the XENIX 286 User's Guide
and learn to use the features described there before using the visual shell.

Notational Conventions
These notational conventions are used in this manual:
•

Literal names are bolded where they occur in text, e.g., /sys/include, printf,
dey_tab, EOF.

•

Syntactic categories are italicized where they occur and indicate that you must
substitute an instance of the category, e.g., filename.

•

In examples of dialogue with the XENIX 286 system, characters entered by the
user are bolded.

•

In syntax descriptions, optional items are enclosed in brackets ( [ ] ).

•

Items that can be repeated one or more times are followed by an ellipsis ( ••• ).

•

Items that can be repeated zero or more times are enclosed in brackets and
followed by an ellipsis ( [ ]••• ).

•

A choice between items is indicated by separating the items with vertical bars

( I ).
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Manual Organization
This manual is organized in the following manner:
Chapter l--Introduction
This chapter introduces the reader to the XENIX 286 visual shell. Included are
manual and shell overviews, user definition, notational conventions, a synopsis of
each chapter and appendix, and a visual shell overview.
Chapter 2--Using the Visual Shell
Chapter 2 provides the reader with instructions for operating the visual shell. This
chapter includes a description of command syntax, the main menu commands and
submenus and examples of how to use the visual shell.
Chapter 3--Advanced Features
This chapter describes the advanced features of the visual shell. After reading
this chapter, you will know how to add and delete commands from a menu, create
new menus, modify existing menus, and use and modify the window.
Appendix A--Command Reference
Appendix A is a summary of the visual shell commands and a directory of the
special keys used in the visual shell.
Appendix B-- Related Publications
This appendix includes a list of Intel publications containing information relating
to XENIX 286.

Visual Shell Overview
Every operating system must have some method of enabling a user to communicate with
the root of the operating system (the kernel); in XENIX this is called the "shell." The
XENIX shell is actually a com mand interpreter that accepts com mands input by the user
and interprets them into bit patterns that the kernel can understand and execute.
XENIX 286 users have four shells to choose from: the visual shell, the Bourne shell, the
C shell, and the restricted shell. Each of these shells is designed for use with certain
applications, but you may use any of the shells at any time (with the exception of the
restricted shell).
While the interface to the Bourne, C, and restricted shells is transparent,
shell interface is highly visible to the user. In the Bourne, C, and restricted
user inputs com mands on a "com mand line" preceded by the system prompt,
visual shell the user selects a command from a list displayed on the screen;
shell is a "menu-driven" program.

the visual
shells, the
but in the
the visual

Because the visual shell is menu-driven it is particularly well suited to environments
where the operator has little or no computer experience or where certain applications
software packages are used constantly. The shell interprets all commands to the
operating system; it replaces the traditional command line with a visual shell that shows
you a menu of the most commonly executed applications and utilities.
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An important feature of the visual shell is that you can customize it for different
purposes. You can create commands and help files as well as tailor the shell for
different applications.
Pressing the HELP key or choosing the Help command displays information about the
visual shell commands and facilities. You can then select the topic you want to explore
by selecting it with the cursor. Selecting not only alleviates having to type the entire
file name or directory name for the topic, but also ensures that you'll select exactly the
file or directory you want to view.
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Introduction
This chapter describes how the visual shell works and how to use it. You will learn how
to enter commands, manipulate files and directories, set visual shell options, use mail,
and print files and directories.

How the Visual Shell Works
When you first enter the visual shell, XENIX displays a list of 12 commands: this is the
com mand menu. From this menu you select the task to be performed. After selecting
the appropriate command, another menu (the submenu) appears with prompts you must
answer. After you fill in the fields for the submenu, XENIX executes the command in
the same way it executes a command entered from the keyboard.
Status Line
The status line is the last line on the screen. It gives you the following information:
•
•
•
•

The path name of the working directory (left-truncated if necessary)
A message if you have mail
The date and time
The name of the operating system (XENIX)

When the operating system is waiting for you to enter commands, the date and time are
monitored and displayed on the status line. The date is updated daily and the time is
updated every minute.
Message Line
The message line is above the status line. The visual shell displays various messages on
this line when you choose commands and execute operating system tasks. Any error
messages you may receive appear on this line.
Command Output
The center portion of the screen appears blank when you start the computer. As you
enter commands, the output of these commands appears in the center portion of the
screen; this center portion of the screen is called the window. The command output
scrolls up each time a new command is typed. The command menu, message line, and
status line are temporarily erased during command execution but are redrawn when the
command has completed.
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How to Use the Visual Shell
The visual shell can be invoked by entering

vsh
at the system prompt. A few seconds after invoking the visual shell, the command menu
appears on the screen. The visual shell can also be set as the shell that you enter as
soon as you log in to XENIX: your login shell. If the visual shell is set as your login
shell, you don't have to invoke it.
The lists of commands on the screen is called a command menu. In fact, any time you
see choices on the bottom part of the screen, that is a menu. You can choose an option
from a menu by pressing the SPACE BAR. As you press the SPACE BAR, watch the
command menu. The highlight moves left to right, stopping at each command. Try
pressing the SPACE BAR to move to each of the different options on the main command
menu. Once you have selected a command, press RETURN and a submenu appears on
the screen. You must fill in the blank fields of this submenu to tell the visual shell what
to do with the command selected.
The BACKSPACE key can be used to back up (move right to left) through the
commands.
To return to the main com mand menu at any time, press the CANCEL key or
CONTROL-C.
Another way to select com mands and other options is to type the first letter of the
command or option while in the command menu. For example, to select Copy, type C.
You do not need to press RETURN; the Copy command will automatically be processed.
If you press a key that does not work as a command, such as the letter J, the command
screen will not change, but you will see the error message "Not a valid option."
Editing Responses to Commands
Each submenu contains command fields that require you to enter a response; the visual
shell provides special editing keys to edit command field responses. The following keys
are listed by FUNCTION only. Refer to Appendix A for the exact key or sequence of
keys that corresponds to these functions.
To replace a response, type the replacement. The visual shell automatically deletes the
original response as soon as you type the new one.
To delete the response and leave the field empty, press the DELETE key.
highlighted text is deleted.
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To append to the response, move· the cursor to the end of the existing response and add
the new text. Once the response is altered, one character or word in the field is
highlighted. This highlight is the edit cursor. The edit cursor may be moved to
designate where or what to edit.
Use the arrow or cursor movement keys to move the edit cursor in the command fields.
CONTROL-K and CONTROL-L move the cursor left and right, respectively, one
character at a time. CONTROL-O and CONTROL-P move the cursor left and right one
word at a time. Note that punctuation marks are considered words.
To insert new text, type the text. It will be inserted in front of the edit cursor.
To delete text, use the BACKSPACE key to delete characters on the left side of the
cursor. Use the DELETE key to delete what is highlighted by the cursor.
To replace text, use the delete key to remove the old text, and then type the new text.

Executing a Command
The visual shell does not carry out the command until you tell it to do so by pressing
RETURN. As shown earlier, the RETURN key is also used after you move the highlight
to a command or subcommand name with the SPACE BAR or BACKSPACE key.
You can press RETURN whenever the responses in all the command fields are correct.
When a command has been carried out, the command screen reappears and waits for a
new command. Note that if you choose a command by typing its first letter, you do not
have to press RETURN.

Canceling a Command
Before you press RETURN to carry out a command, you may press the CANCEL key to
cancel the command. When you press the CANCEL key, the command screen will
reappear and you can choose another command or end the session by choosing Quit from
the command menu.

Redrawing the Screen
You may redraw the screen at any time during the session by entering an exclamation
point (!). When you redraw the screen, XENIX clears it and then displays the current
information again.
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Command Descriptions
The following command descriptions explain the action of each command, the purpose
of the command fields, and the meaning of the messages displayed by a command. The
submenu for each command is displayed immediately under the command heading.
Instructions for using features such as the editor (vi) and mail are provided in the XENIX
286 User's Guide.

Copy
COPY: File

Directory

The Copy command offers a choice of subcommands that perform the following tasks:
•

Copy the contents of a file to a new file

•

Copy the contents of a directory to a new directory

The Copy subcommands are described individually in the following sections.
Copy File
COpy FILE from:

to:

You may copy the contents of any existing file to a destination file. If the destination
file already exists, the old contents are deleted before the new contents are copied to
it. If the file is not in the current directory, you must specify a valid path name.
If you copy the source file to another directory, you may give the destination file the
same name as the source, but you must specify a full path name for the destination file.
Otherwise, you must use a different name.
Copy Directory
COPY DIRECTORY from:

to:

You may copy the contents of any existing directory to a destination directory. If
the directory is not in the current directory, you must specify a valid path name.
The Copy File and Copy Directory commands have the following command fields:
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from:

Enter a file or directory name.
If the file is not in the working
directory, specify a valid path name.

to:

Enter a file or directory name.
If the file is not in the working
directory, specify a valid path name.
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Delete
DELETE name:
The Delete command enables you to perform these delete operations:
•

Delete a file from a directory

•

Delete a subdirectory from a directory

Delete removes a file from the current or specified directory or deletes the directory
specified by the path name. If the file or directory does not exist, the command
displays an error message.
Delete has the following command field:
name:

Enter a file or directory name.

Edit
EDIT file:
This command enables the user to edit the specified file. Edit loads vi and replaces the
command menu screen with the text editor screen. The command menu is restored
when you exit vi.
Edit has the following command field:

file:

Enter a file name. If the file is not in the working directory, you must
supply a valid path name.

Help
HELP: Resume Introduction Next Previous Commands Keyboard Filters Menus
The Help command displays information about visual shell commands; it provides the
following information:
Resume

Exits Help and returns to the previous screen.

Introduction

Displays the beginning of visual shell Help text.

Next

Scrolls Help text ahead one full screen.

Previous

Scrolls Help text in reverse one full screen.

Commands

Displays visual shell com mand information.

Keyboard

Displays information about the keyboard.

Filters

Displays information on XENIX filters FIND, MORE, and SORT.

Menus

Displays information on how to change the visual shell menus.
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Mail
Mail has two commands:
following text.

Read and Send.

These two commands are described in the

MAIL: Read
The Read com mand enables you to read mail sent by other users. Once you have
selected Read, you begin using the XENIX mail system to read your mail. When you
finish reading your messages, enter CONTROL-D to exit mail.
MAIL SEND to:
The MAIL SEND command enabl:~s you to send mail to other users. After filling the
"to:" command field with vali¥dser names, you can then use the normal XENIX mail
commands. When you finish co posing a message, enter CONTROL-D to send it to the
designated users. Chapter 6," ail: The XENIX Mail System," of the XENIX 286 User's
Guide provides complete instructions for using the XENIX mail system.

Name
NAME old:

new:

This command enables you to rename an existing file or directory. The new name must
not be the same name of a file or directory already in that directory.
This command has the following command fields:
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old:

Enter the existing file or directory name. If the file or directory is not
in the working directory, a valid path name must be given.

new:

Enter the new file or directory name. If the file or directory is not in
the working directory, a valid path name must be given.
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Options
OPTIONS: Directory FileSystem Output Permissions
The Options command enables you to select one of the listed subcommands to perform
the following functions:
•

Make a directory (under Directory)

•

Determine disk usage (under Directory)

•

Check a file system (under FileSystem)

•

Determine free space (under FileSystem)

•

Mount a flexible disk (under FileSystem)

•

Unmount a flexible disk (under FileSystem)

•

Change visual shell command output on the screen (under Output)

•

Set permissions for directories and files (under Permissions)

The subcommands are described in the following sections.
Options Directory
The Options Directory menu has two commands: make and usage.
OPTIONS DIRECTORY MAKE: directory:
This command enables you to make a new directory by entering a directory name. The
new directory is a subdirectory of your working directory.
OPTIONS DIRECTORY USAGE: name:
The usage command enables you to determine the number of blocks contained in all files
and directories within each directory and file specified by "name." This command does
not count directories that cannot be read or files that cannot be opened. Files with
holes in them will result in an incorrect block count.
This command has the following command field:
pathname:

Specify the pathname of a directory.
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Options FileSystem
The Options FileSystem menu contains four commands:
Filescheck

Checks and repairs files systems.

Mount

Mounts a file structure.

Unmount

Unmounts a file structure.

Spacefree

Reports number of free disk blocks.

These commands are described in the following sections.
Options FileSystem Filescheck
OPTIONS FILESYSTEM FILESCHECK: device name:
This command is usually run when you have problems mounting a flexible disk on a
system. Options FileSystem Filescheck audits and repairs inconsistent conditions for
file systems. If the file system is consistent, the number of files, number of blocks
used, and number of blocks free are reported. Most corrective actions of this command
result in some loss of data.
The Filescheck option has the following command fields:
device name:

Specify a device name such as /dev/dvfO.

Options FileSystem Mount
OPTIONS FILESYSTEM MOUNT: device name:

directory: read only: Yes (No)

This command option enables you to mount a flexible disk in the system) This command
tells the system that a removable file structure (e.g., a flexible disk) ils present. The
file structure is mounted on a directory. The directory must already exist; it becomes
the name of the root of the newly mounted file structure. Refer to the Options
Directory Make command for information on how to create a directory.
If you have problems mounting a flexible disk, refer to the Options FilesSystem

Filescheck co m m and.
This option has the following command fields:
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device name:

Specify the name of the device you are mounting, such as
/dev/dvfO.

directory:

Specify the name of the directory in which the mounted file
syste m will reside.

read only:

Choose "Yes" if your disk is write-protected. The default is "No".

Using the Visual Shell

XENIX 286 Visual Shell User's Guide

Options FileSystem Unmount
OPTIONS FILESYSTEM UNMOUNT device name:
The Unmount option unmounts a mounted flexible disk file system. Busy file structures
cannot be unmounted with Unmount.
This command has the following command fields:
device name:

Specify the mounted device name (e.g., /dev/dvfO).

Options FileSystem Spacefree
OPTIONS FILESYSTEM SPACEFREE device name:
This command reports the number of free disk blocks. If the device name: command
field is not specified, Spacefree reports free space on all mounted file systems.
The Spacefree command has the following command fields:
device name:

Specify a device name such as /dev/dvfO.

Options Output
OPTIONS OUTPUT commands like: Vshell

Xenix

This command determines how the visual shell will display command syntax when a
command is executed. Normally, the visual shell displays its commands in the command
output area of the screen. For example, when you run Options Directory Make to create
a directory, the visual shell displays "Options Directory Make ••• " when the command
executes. If' you want to see which XENIX command is running, select the "Xenix" field.
The visual shell will display "mkdir ••• " instead of Options Directory Make.
The Options Output command has the following command field:
commands like: Vshell

Xenix

Choose "Xenix" to see actual XENIX commands displayed.
commands ( "Vshell").

The default is visual shell
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Options Permissions
OPTIONS PERMISSIONS filename:
(Yes) No execute: (Yes) No

who: (All) Me Group Others read: (Yes) No write:

Options Permissions enables you to change file and directory permissions and has the
following command fields:
filename:

Type the name of a file or directory.

who:

Enable the permissions group by selecting All (default), Me, Group, or
Others.

read:

Select "Yes" (default) or "No."

write:

Select "Yes" (default) or "No."

execute:

Select "Yes" (default) or "No."

Print
PRINT file:
The Print command enables you to print files on a line printer. The command adds the
specified files to the end of the printer queue. Each file is printed when it reaches
the top of the queue. The specified files must be text files. Print has the following
command fields:
file:

Enter file names.

Quit
QUIT:
Enter Y to confirm:
Quit enables you to leave the visual shell and return to the command shell. You must
type the letter "Y" to confirm that you want to leave the visual shell. On exit from the
shell, the system saves the current environment so you may return to the same point
when you start the shell again. If the visual shell is your login shell, when you quit the
visual shell you will be logged off the system.
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Run
RUN file:

parameters:

output:

Run enables you to execute the program or command specified after "file:".
specified file must be one of the following:
•

An application program

•

An executable XENIX file (including commands)

If the file is not in the working directory, you must supply a valid path name.
the following com mand fields:

The

Run has

file:

Enter a file name, program name, or command name.

parameters:

Enter any arguments to the program or command, including
switches.

output:

Specify a file name or device name to redirect output from the
program or command. Enter a vertical bar (I) to access the menu
of XENIX filters.

View
VIEW name:
This command enables you to view the specified file. If a file is loaded in the window,
you can view the file by using the scrolling keys. If a directory is loaded in the window,
you can travel around the directory by using the SHOW (=) and GOA WA Y (-) keys.
(Appendix A contains a complete list of the keys used in the visual shell.) View has the
following command field:
name:

Enter a file or directory name. If the file or directory is not in
the current directory, you must give a valid path name.

Window
WINDOW redraw: Yes No (default) height in lines: 5 (default)
The Window command turns the window display on or off and sets the window height.
When the window redraw is "Yes," a permanent window appears at the top of your
screen. The window contains the output from the View command and directory displays.
When redraw is "No," a permanent window appears at the View command or when a
direction key is pressed. The default window redraw command field is "No."
You may use the "height in lines:" field to set the window.
lines; the maximum height is 15 lines.

Initially, the height is 5

Window has the following command lines:
redraw:

Choose an option. "Yes" turns the window display on; "No" turns it off.

height:

Enter a number from 1 to 15.
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Introduction
The visual shell is more than just an operating system interface; it is designed to help
you enter commands and perform functions efficiently. Two visual shell features give
you flexibility and power: the window and a modifiable menu structure. You will learn
about the window and how to change visual shell menus in this chapter.

Using the Window
The visual shell enables you to use part of the screen as a window for displaying and
accessing information and manipulating directories and files. The visual shell window
characteristics can be manipulated by using the Window command. The window may be
permanent or temporary. A permanent window is one that has been opened and remains
open until closed; a temporary window disappears after the next command is processed.

Showing the Directory
Just as you can view text files in the window, you can use the direction keys on your
keyboard to view directories in the window.
(Refer to Appendix A, "Com mand
Reference," for information on the direction keys UP, DOWN, LEFT, and RIGHT.) When
you use one of these keys, a temporary window appears on your screen and remains
there only until you execute a visual shell command.
To display a directory, press one of the direction keys when the main command menu
appears on the screen. A temporary window will be drawn in the upper portion of the
screen. The window displays a directory listing for your working directory, showing the
names of files and directories. Directories and subdirectories are shown in brackets
([]), and each executable file is preceded by an asterisk (*). Text files are not marked
in any special way and device special files are not listed.
You can use the direction keys to select file and directory names displayed in the
window. The bottom border of a window always contains information about the selected
directory or file. The border tells you the name of the directory (or file), its size in
bytes, and the date it was last modified. For example:
_ _ myfile _ _ 621 bytes _ _ modified Aug. 2, 1983
Two special keys are used with the window: SHOW (=) and GOAWA Y(-}. If the cursor is
highlighting a directory, you can press the SHOW (=) key to display the listing for that
directory. Pressing the GOAWA Y (-) key returns the display to the parent directory.
(You can always access a parent directory by pressing the GOA WA Y key.) Using these
two keys, you can change your current working directory.

3-1

Using Advanced Features

XENIX 286 Visual Shell User's Guide

The following example demonstrates how to view a directory and use the SHOW and
GOAWAY keys.
Press one of the direction keys to display your working directory in the window. For the
purposes of this example, your working directory is named lusrlsue. There are several
subdirectories in the lusrlsue directory, including one named formats. To view the
directory named lusrlsue/formats, follow these steps:
1.

Use the direction keys to select the formats subdirectory.

2.

Press the SHOW key (=) to view the lusrlsue/formats directory.

3.

Press the GOA WA Y key (-) to display the lusrlsue directory.

Showing Text Files
The SHOW and GOA WA Y keys may also be used to display a text file. Press a direction
key to display the working directory in the window. Select the name of the file you
want to view and press the SHOW key. The directory disappears and is replaced by the
selected text file; use the arrow keys to move through the file. When you press the
GOAWA Y key, the working directory is redisplayed in the window.
You can only "show" text files that reside in the directory currently displayed on the
screen. To display other text files, change directories or use the View command and
specify a full path name.
The following example demonstrates how to show a text file.
1.

Press one of the direction keys when you see the main command menu on the
screen. Your working directory appears in the window.

2.

Select a file from the working directory.

3.

Press the SHOW key.

The selected file appears in the window. To return to the working directory, press the
GOAWAY key.

Changing the Window Size
Windows displayed in response to pressing a direction key are temporary windows that
disappear after the next com mand executes. The Window com mand enables you to
create a permanent window and change the window size.
To expand the window size from the default five-line window, choose the Window
command from the main command menu; the Window menu appears. This menu asks you
whether you want to redraw the window after each command. The default is "No." To
create a permanent window, go to the "redraw:" com mand field and choose "Yes." To
establish a larger window, use the TAB key and move to the "height:" command field.
Type a number from 6 through 15. (The window cannot be more than 15 lines long.)
When you press the RETURN key, the main command menu appears. A permanent
window is displayed on the screen until you close it by using the Window command.
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To close the window, choose the Window command from the main command menu.
Choose the "No" option in the "redraw:" command field. Press RETURN. The display
returns to the main command menu, and the window will not appear until you press a
direction key.
To create a permanent 10-line window on the screen, follow these steps:
1.

Choose the Window command from the main command menu.

2.

Go to the "redraw:" command field and choose "Yes."

3.

Press the TAB key and move to the "height:" command field. Type the value 10.

4.

Press the RETU RN key.

The main command menu appears and a window 10 lines high is displayed in the upper
part of the screen. To close this permanent window, choose the Window command and
go to the "redraw:" command field. Choose "No." When you press RETURN, the main
com mand menu appears and the window is closed.
You can decrease the window size by using the same procedure but specifying a smaller
window size. The window size must be between 5 and 15 lines long.

Using the Window with Simple Commands
Using a window enables you to specify file and directory names by selecting them from
the window. The following example copies the file temp! to a file named temp2.
1.

In the main command menu, type C. The Copy menu will appear on the screen.

2.

The cursor should be in the "from:" com mand field. Do not type the file name
templ. Instead, press any direction key so that the working directory appears in
the window.

3.

Use the direction keys to select the file temp! from the window. Notice that as
you press the direction keys, the "from:" command field changes in the Copy
menu. Each file selected from the window appears in the "from:" field at the
bottom of the screen.

4.

When the name temp! appears in the "from:" field of the Copy menu, use the TAB
key to go to the "to:" field.

5.

Type the file name temp2.

6.

Press RETU RN.

Output from the Copy command ("1 file copied") will appear in the command output
section of the command screen. Both file and directory names can be selected to fill in
command menus. Experiment with various commands by using the window to fill in thecom mand menus.
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Modifying the Menus
You can modify menu commands (except those in Help) at any time. While in a menu
(for example, the main command menu), you can change the commands on the screen by
pressing the MODIFY key (@). When you press @, the Modify menu is displayed.
The choices on this menu are Insert, Delete, and Rename. The following sections
discuss what happens when you choose each of these commands.

Adding Commands to the Menus
To add a command to the main command menu, first press the MODIFY key and then
select the Insert option. Fill in the command fields with the following information:
•

The name of the command as you want it to appear on the menu.

•

The name of the corresponding XENIX command.

•

Where you want the com mand to appear on the menu.

When you press the RETURN key, the com mand will be added to the main command
menu.
The following example adds to the main menu a command that lists the permissions of a
file or directory; the menu command is called List and corresponds to the XENIX I
command. To add the List command, follow these steps:
1.

When the main command menu is displayed, press the MODIFY key. The Modify
menu will appear.

2.

Choose the Insert option.

3.

Press RETURN. The Modify Insert menu appears and displays the following fields:
"menu item:", "for command:", and "before item:".

4.

Type "List" in the "menu item:" field.

5.

Go to the "for command:" field and type I for the value of the List command. (If
the command were an executable file, you would specify its file or path name.)

6.

Go to the "before item:" field. This asks you which command you want List to
precede on the menu. Type "Mail". (If you want the command to come at the end
of the command menu, leave the "before item:" field blank.) You can also press
the direction keys to scroll through the existing commands.

7.

Press RETURN. The main command menu will include the new List command
between Help and Mail.
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Do not name your commands with letters that have already been used on the command
menu. If you choose a letter that is already taken, the visual shell will ask you to
specify a different name for that command.
The visual shell recognizes all XENIX operating system commands and creates a
submenu for each one you add to a com mand menu. To illustrate this, let's use the new
List command. In the command menu, go to the List command and press RETURN. A
special default command menu for the List command will appear on the screen. This
menu asks you to specify the parameters for the List command. Type the name of the
directory you want to view in the "parameters:" com mand field. When you press
RETURN, you will be returned to the command screen, and the specified directory will
appear in the window.
If the directory you want to view is not a subdirectory of your working directory, you
must type the path name of the directory in the "parameters:" command field.

Deleting Commands from the Menus
To delete a command from the main command menu, press the MODIFY key while in the
command menu. (You do not have go to the command you want to delete.) The Modify
menu will appear. Go to the Delete option and press RETURN. The Modify Delete
menu will ask you which command you want to delete. Type the name of the command
you want to delete in the "DELETE menu item:" field. You can also use the direction
keys to enumerate which command you want to delete. When you press RETURN, the
main command menu will be displayed; it will no longer contain the command just
deleted.
To delete the List command just added to the main command menu, follow these steps:
•

Press the MODIFY key when the main command menu is displayed.

•

Choose the Delete option from the Modify menu.

•

Type the word "List" in the "DELETE menu item:" field.

•

Press the RETURN key. The visual shell will redisplay the main command menu
without the List command.

You cannot delete the Help command or any of the commands in the Help menu.
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Renaming Commands
Besides adding and deleting commands, the visual shell also enables you to rename any
command in a menu by using the Rename command.
For example, you may want to rename the Delete command to "Erase." (You may want
to do this to add a command that starts with the letter "D," which conflicts with the
Delete command.) To rename a command, choose the Rename option in the Modify
menu. The Modify Rename menu asks you which command to rename. Fill in the three
command fields and press the RETURN key. The main command menu appears and
includes the new command name.
The following steps illustrate how to rename the Delete command to Erase.
1.

While in the main command menu, go to the Delete command and then press the
MODIFY key. The Modify menu will appear on the screen.

2.

Go to the Rename command and press RETURN.

3.

Three fields appear: "from:", "to:", and "before item:". Each will have "Delete" as
the current value of that field. Change the "to:" field to "Erase."

4.

Go to the "before item:" field. Use the direction keys to scroll through the
existing commands and select the menu item you want the renamed command to
precede. Select Help.

5.

The visual shell checks to see if there are any commands in the main command
menu that begin with the letter "E" and returns you to the main com mand menu if
there are no conflicts. The Delete command is now renamed Erase.

If you have chosen a letter that is already used on the menu, the visual shell prompts
you to choose a different letter.
With so much naming and deleting possible, you may forget which commands are
associated with which functions. The visual shell provides you with a way to check the
value of each command. Press the MODIFY key when the main command menu is on the
screen. Go to the "for command:" command field. You can press the right and left
direction keys to scroll through all visual shell com mands and their associated values.
You always have a current command status list that you can check if you forget a new
com mand name or function.
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Creating and Deleting Submenus
Creating and modifying submenus is easy with the visual shell. You must first decide
what to name the main menu item. The command and its associated submenu must have
the same name. Use the MODIFY key to display the Modify menu, then choose the
Insert menu.
There are three fields in the Modify Insert menu: "menu item:", "for command:", and
"before item:". To add a submenu, type the name of the command (and its associated
submenu) in the "menu item:" field. Next, go to the "for command:" field. Instead of
typing a file name, type the word "Menu". This tells the visual shell that you are
planning to add a submenu to the system. When you press the RETURN key, the visual
shell will display the main command menu with the new top-level command.
So far, you have created a submenu, but that submenu has no com mands in it. To add
commands to your new submenu, choose the top-level command and press RETURN. You
should see the name of the new submenu displayed on the screen. You can use the
MODIFY key to call up the Modify menu and add commands to the submenu. Follow the
steps described in "Adding Commands to the Menus" in this chapter to add commands to
the submenu.
Commands are deleted from a submenu the same way they are deleted from the main
command menu. Refer to "Deleting Commands from the Menus" in this chapter for
more information. You cannot delete a submenu until each command has been deleted
from it.
For example, suppose you want to be able to access several editors by using a submenu
under an Edit main com mand. These editors are named Word, Notepad, and Text.
You must first add the top-level command to the command screen using the MODIFY
key and the Insert option. Follow these steps:
1.

When the main command menu is displayed, press the MODIFY key. The Modify
menu will appear.

2.

Type "Edit" in response to the "menu item:" field and "Menu" in response to the
"for command:" field.

3.

Press RETURN. The main command menu appears; the Edit command has been
added to this menu.

4.

Choose the Edit command and press RETURN. The screen displays "EDIT". Press
the MODIFY key to display the Modify menu. Choose the Insert menu.

5.

Add the first editor by typing the name of the editor (for example, Word) in the
"menu item:" field and the path name of the editor (for example: tbin/word) in the
"for com mand:" field.

6.

Press RETURN to display. the main command screen.

7.

Repeat steps 4, 5, and 6 to add Notepad and Text subcommands to the Edit
submenu.
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To delete the submenu, first use the Modify menu to delete the com mands Word,
Notepad, and Text. Next, return to the command screen and use the MODIFY key to
display the Modify menu. Choose the Delete menu and type "Edit" in response to the
"command:" field. When you press RETURN, both the submenu (named Edit) and the
top-level Edit command will be deleted.

Modifying Fill-in Fields
In the previous section, you learned how to add, delete, and rename commands and how
to create and delete menus and submenus. This section describes how to change and
create fill-in fields, which are the prompts you respond to once you have selected a
command •

.mnu Files
All XENIX com mands are actually executable files on disk. You can see the files when
you display a directory listing for the directory that contains XENIX commands on your
system (usually Ibin). Most XENIX command files have an associated file called an .mnu
file. All files have file names that end with .mnu. An .mnu file contains the
information necessary for the visual shell to create a command submenu and describes
the following:
•

The submenu(s) for one operating system comma,nd.

•

The defaults and possible values of the fields within the submenu(s).

•

The actual command line arguments to be used once you press RETURN. These
arguments act as a template into which values from the submenu are inserted.

•

Help text. This text appears on the screen if you press the HELP key (?) while the
command submenu is displayed.

The .mnu files are stored in a separate directory called Ibin. Use the View command or
the SHOW key to see which files have associated .mnu files. Notice that each command
is matched with a file that ends with .mnu.
If you add commands to the visual shell using the MODIFY key, you do not have to add a
corresponding command menu. When you choose the new command, the visual shell first
searches in the Ibin directory to find a .mnu file that corresponds to the command. (For
example, a Finger command might have an associated finger.mnu file.) If there is no
associated .mnu file for the command, the visual shell displays a default command
menu.
You can create your own command menus by writing an .mnu file that corresponds to a
command added to the visual shell. The following section demonstrates how to create
an .mnu file.
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Creating .mnu Files
If you add commands to the command menu, you can access the visual shell default
command menus or create your own command menus. To create your own command
menus, you must write an .mnu file for each command you want the visual shell to
process.
An • mnu file describes
•

Displayed prompts on com mand menus

•

Fields within command menu prompts

•

Operating system command line arguments

•

Help text for a com mand (optional)

Special characters (=, "', #, -, and ') can be included in any .mnu file text string by
preceding them with a tilde (-).
Prompts
Prompts are typed into the .mnu file as they will appear on the screen.
characters are inserted where necessary to delimit fields.

Special

Fields
There are two types of fields:
Menu fields:

Field selection is with a menu. Example: who:
(You choose one of these options.)

Me All Group Others

Fill-in fields:

The response is text. Example: file name: (You enter a file name.)

Beneath the description of each prompt in the .mnu file is a list of field descriptions.
There is one description for each field in the prompt. Each field description indicates
the field's type, default value, and other type-specific information.
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Table 3-1 is a list of field types.
Table 3-1. XENIX 286 Visual Shell Field Types

Field Type

Description

SELECT

Selection menu

FILENAME

Allows window selection and typing

FILEN AMELIST

Allows window selection and typing

PARAMETERS

Text field

OUTPUT*

Output field

NUMBER

Integer field (number)

DIRECTORY

Allows window selection and typing

*OUTPUT fields determine redirection of I/O. If used, the visual shell adds the
necessary symbols, commands, and file names to the command line.
Each field type has a fixed prompt that will appear at the bottom of the menu when the
field is selected, for example, "Enter a file name".
Each field type may be followed by a default specification (that is, the option
automatically suggested when the command menu first appears). Table 3-2 lists several
different kinds of default specifications.
Table 3-2. XENIX 286 Visual Shell Field Type Default Specifications

Default Value

Description

POINT

File or directory from directory window (if open).

<number>

Indicates option in menu-type selection.

'any string'

A string for a fill-in field. Quotation marks will
be stripped. For example, note that a NUMBER
field is a fill-in field, so its default is a quoted
string.

For purposes of command line construction, SELECT field types must always be
followed by a series of text strings, one for each option in the field. These are generally
used to specify switches.
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Command Lines
After you have described the command menu prompts and fields, the .mnu file must
contain a description of the command line. The visual shell uses this information to
build the line that will be executed by XENIX. The command line description is a
template with placeholders for variables that the visual shell will provide.
The
placeholders take the form "x, where x is an integer that indicates the command menu
field that supplies the value. The template appears as "EXEC = template" in the .mnu
file. The visual shell appends these arguments to the command name before the
com mand is run.
Help Text
Help text is text that appears whenever you press the HELP key or use the Help
command. This text will only be displayed if you ask the visual shell for help when
choosing the top-level command or while in the command submenu.
To enter help text, type any help text after the command argument line (EXEC=) in the
.mnu file. Your help text should begin after this line. Help text must be separated by a
line consisting of five hyphens.
Example
GET string:"" file:"" linenumbers:"Yes No"
case sensitive:"Yes No" output:""
fields
1 PARAMETERS
2 FILENAME
3 SELECT = 2

'-n' "
4 SELECT =

" '-y'
5 OUTPUT
exec = 'fgrep "3 "4 "1"2'
GET finds a string in a file. If the "linenumbers:" command field is set to Yes,
GET reports the line numbers that contain the string. If the "case sensitive:"
command field is set to Yes, GET reports strings that exactly match the string and
does not ignore case. You can direct output to a file or printer by specifying a
file name or device name in the "output:" command field. Typing a bar symbol (I)
in the "output:" command field brings up the menu of XENIX filters.
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Keyboard Summary
In this manual, the keys are referred to by their functional names (e.g., SHOW, HELP)
rather than by what may be written on the key.
The following section lists the basic key assignments provided with the visual shell.
Depending on the keyboard you use, you may have additional function keys or different
key assignments. An extended chart, which lists terminal-specific keys, is available in
the visual shell by pressing the letter H (for Help) and then K (for Keyboard). (Press N,
for Next, to view more of the chart.)
These keys perform the following functions only in conjunction with visual shell menus.
They may not work in the same manner if used ~during application programs or during
operating system com mands.
For some functions, several alternatives are listed, separated by commas. CONTROL(letter) means press the CONTROL key and the letter simultaneously. Some functons
list two control characters separated by a plus sign (+); both control characters must be
pressed, in the sequence listed, for the function to work.
Key Chart

Key

Function

CONTROL-E

(UP) Moves the cursor up one line.

CONTROL-X

(DOWN) Moves the cursor down one line.

CONTROL-S

(LEFT) Moves the cursor left one character.

CONTROL-D

(RIGHT) Moves the cursor right one character.

CONTROL-R + CONTROL-X

(P AG E UP) Scrolls up one full screen.

CONTROL-R + CONTROL-E

(PAGE DOWN) Scrolls down one full screen.

CONTROL-R + CONTROL-S

(P AG E LEFT) Scrolls one full screen left.

CONTROL-R + CONTROL-D

(PAGE RIGHT) Scrolls one full screen right.

CONTROL-Q

(HOME) Moves the cursor to the beginning of the file
or directory listing.
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CONTROL-Z

(END) Moves the cursor to the end of the file or
directory listing.

CONTROL-C

(CANCEL) Cancels present operation and returns
to main command menu.

RETURN

(RETURN)
menu.

SPACE BAR

Selects the next item on a menu.

BACKSP ACE, CONTROL-H

Selects the previous item on a menu. When editing
responses in command fields, deletes selected
characters. Replace ment text may be typed.

TAB, CONTROL-I, CONTROL-A

(TAB) Moves to and selects the entire contents of
the next field in the command line.

CONTROL-Y, DELETE

(DELETE)
Deletes
selected
Replacement text may be typed.

CONTROL-L

(CHARACTER RIGHT) Selects the character to
the right of the current character.

CONTROL-K

(CHARACTER LEFT) Selects the character to the
left of the current character.

CONTROL-P

(WORD RIGHT) Selects the word to the right of
the current word.

CONTROL-O

(WORD LEFT) Selects the word to the left of the
current word.

?

(HELP) Requests information about the selected
command or the command in progress at the time
of the request.

=

(SHOW)
Displays directories and text files;
displays submenus for commands in the window.

Executes a command selected from a

characters.

(GOA WAY) Returns the window display to the
parent or current directory.
@

(MODIFY) Displays the Modify menu.
(REDRA W) Redraws the screen.
(BAR) Displays the menu of XENIX filters.
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Command Summary
Copy

Enables the user to copy files or directories to other files and directories.

Delete

Deletes a file from the current or specified directory, or deletes the
directory specified by the path name. If the file or directory does not exist,
the command displays an error message.

Edit

Loads vi and enables the user to edit or create the specified file.

Help

Displays information about the visual shell and its commands.

Mail

Enables the user to read mail and send mail.

Name

Renames a directory or file.

Options

Offers a choice of subcommands to enable the user to perform the following:
Make a directory
Determine disk usage
Create a file system
Check a file system
Determ ine free space
Mount a flexible disk
Unmount a flexible disk
Set permissions for directories and files
Change visual shell command output on the screen

Print

Prints a file or files on the system's line printer.

Quit

Exits the visual shell and returns user to the login shell. If the visual shell is
the login shell, then Quit logs the user off the system.

Run

Runs the program or command specified by "file:".

View

Enables the user to look at a file or directory by loading the file or directory
into the window.

Window

Enables the user to turn the window display on or off and set the window
he'ight.
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Intel Publications
Copies of the following publications can be ordered from
Literature Department
Intel Corporation
3065 Bowers Avenue
Santa Clara, CA 95051

XENIX R. 3.4 Reference Library: Basic System

of the XENIX 286 Operating System, Order Number 174385 -- XENIX history,
XENIX uses, basic XENIX concepts, and an overview of other XENIX manuals.

Overview

XENIX 286 User's Guide, Order Number 174387 -- a brief survey of common commands
plus full chapters on the ed text editor, the vi text editor, electronic mail, the Bourne
shell (sh), and the be calculator.
XENIX 286 Visual Shell User's Guide, Order Number 174388 -- a XENIX command
interface ("shell") that replaces the standard command syntax with a menu-driven
command interpreter.
XENIX 286 Installation and Configuration Guide, Order Number 174386 -- how to install
XENIX on your hardware and tailor the XENIX configuration to your needs.
XENIX 286 System Administrator's Guide, Order Number 174389 -- how to perform
system administrator chores such as adding and removing users, backing up file systems,
and troubleshooting system problems.
XENIX 286 Communications Guide, Order Number 174461 -- installing, using, and
administering XENIX networking software.
XENIX 286 Reference Manual, Order Number 174390 -- all commands in the XENIX 286

Basic System.

Related Publications

XENIX 286 Visual Shell User's Guide

XENIX R. 3.4 Reference Library: Extended System
XENIX 286 Programmer's Guide, Order Number 174391 -- XENIX 286 Extended System
commands used for developing and maintaining programs.
XENIX 286 C Library Guide, Order Number 174542 -- standard subroutines used in
programming with XENIX 286, including all system calls.
XENIX 286 Device Driver Guide, Order Number 174393 -- how to write device drivers
for XENIX 286 and add them to your system.
XENIX 286 Text Formatting Guide, Order Number 174541 -- XENIX 286 Extended
System commands used for text formatting.

Other XENIX Publications
XENIX Networking Software Installation and Configuration Guide, Order Number
135146 -- installing, configuring, and administering the XENIX OpenNET'M network.
XENIX Networking Software User's Guide, Order Number 135147 -- user's and
programmer's reference to the XENIX OpenNET'M network.
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